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Please note

To avoid at least some confusion, in these notes a ‘film-slide’ is the
product of a conventional film camera, the product of a film camera, and
a ‘picture’/ ‘image’ is the product of a digital camera or of some magic
worked on your computer. Film-slides and picture images are turned into
slides to be used in a digital presentation.

Similarly, words in italics are computer-speak jargon or commands
(instructions to your computer), where the words have a particular
meaning in this context and do not necessarily mean what the dictionary
has always had us believe.
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You already have a conversion programme in your computer — a small programme called
Paint which is found under Start > All Programmes > Accessories >Paint. You might wish
to find this programme first of all, open it up and then minimise it on to the lower toolbar.

Now open up Google Maps on the internet, navigate to the map you wish to use and just above
the map press Print. This will bring up an enlarged map image without much of the
surrounding data. Press the Print Screen button which should be on your keyboard (not
on the screen — it is usually somewhere on the upper right of your keyboard). This will
temporarily save the image into the clipboard memory of your computer. Cancel the Print
Menu which will appear superimposed on top of this map image.

Next bring up the Paint programme you found before, put your cursor near the top left of
the screen, press the left mouse button and then press Control+V. The screen image of
your map with the Google toolbar etc. will be pasted into your Paint programme screen.

It is now possible to change the image into JPEG by saving the image which is now on
the screen. Choose File > Save as and you can now choose JPEG. Once you have done
this you can save this to a convenient place, perhaps the desktop, as a JPEG file which is
now usable in your Photoshop programme.

Open this picture file in Photoshop and crop off all the Google toolbar and other parts you don’t
need. You have created a new working image. Remember to confirm on the top toolbar
under Image >Mode that RGB is selected.

This image can be used just like a photograph. Remember to save it first, then you can
crop it to your working size (1024 X 768 of course). You can now add text, and in
particular you can draw in a route, perhaps using the pencil tool from the toolbox.

Remember that with tools such as the brush or pencil tool you can select any colour. Go
to the black box at the bottom of the toolbox, right-mouse-click on it, and up will come
a colour picker frame and you can choose any colour you wish. This means that you can
use different colours to indicate types of information relating to the map — perhaps to
accentuate roads or features, or to add in a route, or to shade in a particular region.

Text can actually be rather difficult with a map, which may be already filled with lots of
other text. I would suggest in this instance that you create a white blank area for your text,
so that it is not muddled up with the rest of the map.

To do this use the rectangular marquee tool from the foolbox and draw a selected area, preferably on
the top of your map image. Right mouse click in this area and select fill. A fill box will appear and you
can select white, or navigate to an alternative colour as you wish.

Select your Text tool from the toolbox and type in your text. Then click anywhere on the
rest of the map. When you select Layer from the top menu you can click on Image merge
to consolidate the text. Your new map can now be saved and used in your presentation
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From slides to digital — and enhanced presentations

Once you have experienced a digital lecture that has been well put together and well
presented, any film-slide projection lecture will almost certainly seem second rate. There
is no clunk of film-slides changing, and all the picture images are instantly in pin-sharp
focus, with no adjustment needed after the first picture is shown. If the speaker has taken
the time, the names of plants can be superimposed on any appropriate image. With the
right projection programme, a subtle fade (or dissolve) can be made to take place between
the pictures. This can make the presentation sequence progress so smooth that the
audience completely forgets about the projection and becomes totally immersed in the
speaker’s story.

These notes have been written to explain and clarify some of the problems likely to
be encountered in changing from traditional film-slide presentations and lectures to using
digital projection systems. The same methods can, of course, be used to set up your own
personal library of pictures, without making a presentation. The discussion focuses on
digital photography, putting together a digital show, buying or using projectors, and a host
of tips to help the sequence run smoothly. There are some personal suggestions, but the
great flexibility of our new digital world means that you can, and should, build-up your
own presentation in an individual way, once the basic principles are understood.

The appendices provide greater detail and step by step descriptions are given for
programmes such as Photoshop Elements. Please remember that different versions of such
programmes often use slightly varying menu and key sequences to achieve the aimed for
result, but the procedures described are very similar. There are nearly always other
methods of preparing a presentation. These notes describe sequences which have been
tried and tested but new software and methods will undoubtedly appear. This is just a
guide and, as with all technical guides, it will get out of date.

I also aim to throw light on some of the technology involved. The notes refer to a PC
system, but Macintosh computers work in a very similar manner. All photographic and
display systems, whether mechanical or digital, can of course be vulnerable to problems
and even failure. Experience has shown that a well-prepared digital procedure is the most
reliable. The use of digital images also allows display techniques which are virtually
impossible with a film-based system

Although written for the Hardy Plant Society, with examples of a horticultural nature,
these notes will, I hope, help you to make the transition to digital presentations whatever
your field of interest.

John McCormack
Hertfordshire Group
The Hardy Plant Society
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Go back to Slide Show on the menu bar and choose: Set Up the Show — this will open the
Set up Show control box. In this box select:

Show type: Presentation by Speaker

Show Slides : All

Advance slides: manually

Slide show resolution : 1024x768

Click OK

Again, you can now save this as a presentation. (Using File > Save as) directly on to your
hard disc and/or transfer to your laptop for your live presentation.

When you wish to play your slide show, double-click on the icon of this file, it will bring
up PowerPoint with the album all ready to run. Just press F5 and the slide show will start.

Power Point Viewer

A slightly more sophisticated method is to download the mini-programme, PowerPoint Viewer,
a free download from Microsoft. The advantage is that you can save a shortcut of this Viewer
programme on the desktop screen. When you come to the actual presentation, you just
open the viewer programme and in the selection box click on your Photo Album file. This
will then be opened full screen at the first picture without revealing to the audience the
open PowerPoint programme itself.

Pictures to Exe

There are a number of other presentation programmes available. Pictures to Exe is favoured by many
members of camera clubs for digital presentation. It can be downloaded as a free trial over the internet,
and the final charge for the basic software, which is completely adequate for our use, is around $40.
I'have used this many times and would particularly recommend its /elp file, which teaches you how

to use the programme.

Appendix L: Working with Google maps

Google maps for our purpose are copyright free, so are ideal for use as projected images in
a presentation.

Google maps cannot be saved directly as JPEG images, so if you want to use one for
illustrating your lecture, there are some additional steps to go through. By far the most
simple way is to go into Google Maps, navigate to the geographical area you wish to use
and to print this out as a hard copy. You can then scan this and with the scanner software
save this image as a JPEG file. (If you don’t have a scanner you could photograph the
map, though there will probably be some distortion.) Now you have an image which you
can open in Photoshop and can add additional data.

You can also take a Google bitmap image and turn it into JPEG format without scanning, but several
stages are necessary and it is a more involved procedure. Again it needs some practice.
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suggest first of all making a practice folder, perhaps of some discarded images, and using
it to become familiar with the settings you are going to use with your master lecture
pictures.

First you must create a Photo Album. Then you can set up the actual presentation folder
all ready for the projector. Remember to work on a duplicated folder.

Open PowerPoint

On the menu bar >Insert > Picture > New Photo Album.

This brings up the Photo Album control box.

Choose Insert picture from file/disk, > Insert new pictures box appears

In the Insert New Picture selection box navigate to the practice folder you have made
containing your sized and numbered images. Click to open it.

Next click on the first picture, press Control+A to select all picture and then click insert
This takes you back to the Photo Album control box again, but with your new list of the
pictures appearing in the left hand Photo Album window box. One image should be
visible in the right hand viewing box.

At this stage you can preview the pictures and remove any not required. New images can
be added too. Finally click and select the top image on the list, press the shift key and
navigate with the small sl/ider bar to the bottom picture, keeping the shift key depressed.
Click on this bottom picture, and all the image numbers should be coloured blue and
properly selected. Click create, and you should then return to the Power Point main page with
all your pictures in the left hand column. (You can change the title page text and type in
your own title, or delete that slide.) You now have created a Power Point Photo Album that
can be saved on your hard disk or elsewhere.

This Photo Album can be fine tuned to make your presentation really professional. Click
Control+A on the top picture in the left column of images, so that all are selected.

Go to the menu bar > Slide Show> Slide translation. This opens a new window which
enables you to apply dissolves to your presentation.

In the slide transition window choose:

Apply to selected slides — fade smoothly could be a choice but remember you have
selected all slides, so this will apply to all images.

You can modify the fade/transition to your preferred speed — perhaps start with medium.
Click on the box for Advance slide on mouse click.

Now you can double check your presentation again by clicking the Slide Show button on
the lower right of the screen. This opens up the slides to a full screen size. You can now
play your sequence by using the forward and back keyboard buttons. If all is well, press
escape to return to your main screen.
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First, I think it worthwhile to go over some recent changes in equipment and how it will
affect us. Let’s remember that success in communicating to an audience often depends on
good photographic images — the depth of colour saturation and the sharpest, most
accurate images have the greatest impact.

I Projectors and Projection

Many speakers, and many Local Groups who hire speakers, are now considering
obtaining a digital projector instead of buying a replacement for their ageing slide
projector. Choosing a digital projector can be difficult if you don’t have hands-on
experience of digital projection techniques. It’s always worthwhile getting advice from
someone locally with this experience, but if that isn’t an option then here are some
suggestions.

Most small to medium halls, which can accommodate 50—100 people for a typical lecture,
will need a projector with a minimum of 2000 ansi lumens to illuminate a screen large
enough for an adequate 2m by 2m display. (Ansi lumens are the output units of digital
projectors). On a dark evening with good curtains and blinds, and a smaller audience,
then less projector illumination will be needed than on a sunny afternoon in a full hall
with poor blackout. The worst-case scenario is that the back rows of the audience can’t
really see the screen images at their best. A lecturer who is buying a projector to use in a
number of different situations might usefully consider purchasing a more powerful one to
cover all eventualities. Because many schools are now using digital white boards which
use a similar digital projector (which can show stills and video), competition has forced
prices down, and a more powerful projector giving a brighter picture may well be
considered — the cost is falling, not increasing.

Unlike slide projectors, digital projectors do not use a bulb, but instead have a discharge
tube for the light source. There is no filament to blow and the tubes usually last around a
thousand hours or more. Usually, the tubes eventually fail with a gradual dimming of the
light output, not with a sudden bulb catastrophe, so a spare discharge tube is not a priority
(it may cost half as much as the projector!). But there is an important rule with the care
of these projectors, and that is not to suddenly switch the power off at the end of a lecture,
but to allow the fan to run on and cool the tube for a minute or so. There is usually a
proper power-down sequence built into the projector switching to aid this, but beware of
a ‘helpful’ person just pulling the plug out of a wall socket! This could destroy the
discharge tube which needs cooling down first. Careful handling of all projectors is
absolutely essential, especially when loading in and out of a car — particularly on a dark
evening.

An important advantage of digital projectors is that the shape of the projected picture can
be changed to make good any skewed image. With a slide projector, if the screen is lifted
up high and the projector is on a stand in the middle of a hall, a distorted picture can result
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mainly for lectures and presentations using a computer system, but the images may also
be used for printing. There are many pictures in your files which the HPS Image Library
is keen to use, and these pictures should be taken at the maximum pixel density that your
camera can achieve.

Please do not be put off by the paragraphs which follow here, which are appropriate to
professional or near professional photographers. However, you should be aware of the
gold standards which hopefully we will all eventually attain.

Pictures for a larger size printed poster, or for reproduction on a glossy magazine cover
require higher image quality. There are a number of commercial picture libraries which
demand very high standards so that their images can be reproduced for this type of use.

These requirements may well not be possible or necessary for smaller amateur societies,
but as more members are now acquiring top quality SLR cameras it is worthwhile
explaining the requirements.

A major stock picture library such as Alamy requires uncompressed images of at least
48mb. Other botanical picture libraries require similar quality images. To achieve this
you need an SLR or other high quality camera taking pictures of at least six to eight
megapixels. Pictures should be taken in an uncompressed format, e.g. TIFF or RAW (not
in the more usual JPEG format). Most cameras compress JPEG images, and at this quality
level may damage the purity of the picture.

The TIFF or RAW images will create a non-interpolated file size of around
17 MB at 8 bit, which is the most common camera recording level. These pictures can be
digitally enlarged, with no loss of quality, to obtain a final size of around 50mb.
You can find out how to do this at:

http://www.youngimaging.com/Article-HowDolISizeAnlmageSoAlamyWill Acceptlt.asp

You will then have an image of the highest standard which would be suitable for any form
of use or reproduction. Also it is the image size you might use for selling your pictures.

Appendix K: PowerPoint Presentations — some details

PowerPoint is a large programme, and it can be used to make all kinds of animation effects
and to show video. However, as a photographer you are far more likely to be using
Photoshop to create and adjust your picture folder. When the pictures are ready for
presentation, showing them is best carried out by a dedicated presentation programme.
PowerPoint is ideal for this, and the subtle dissolves between images can be added.

Here are brief instructions to use PowerPoint. The programme itself has a good help file, but
a proper manual is probably necessary for anything more than this basic procedure.
This sequence is quite complicated, so to make sure you have understood it I would
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Many new models of all types of camera now have some kind of vibration resistance,
either built into the camera itself or into some removable lenses. This improves the ability
to take photographs with a shaky hand or in difficult conditions. It is a worthwhile
feature.

It should be added here that if these options are available, pictures should be taken with
the colour space set to Adobe RGB, and not to sRGB, which does not accept so many
colours. Also use the highest setting for JPEG images. Cameras which have the ability to
take RAW or TIFF images can be set to employ these preferences, but the sequence to
make these image files usable is beyond this article. It is assumed that photographers
using these options know how to manipulate such files.

Small, pocketable, digital cameras are amazing pieces of technology, but their
miniaturised components have limits in producing the top quality images. They will
produce excellent photographs for viewing on a monitor or for making small prints,
which is what they are designed for. However, they will rarely produce pictures with the
image quality, sharpness or colour saturation that is really needed for bigger prints or
projection on to any larger size screen. The truth is that the larger the camera, the bigger
the sensor, and its superior lens with more elements will together produce a better image.
You have to balance the portable convenience of the small camera against picture quality.
Once again it is the ‘family snap’ against an image which will stand up to scrutiny by your
fellow horticulturalists, whose knowledge of plants is often of a professional standard.
With a good SLR camera it is really quite feasible to raise pictorial standards to a level
which matches the factual excellence of the rest of the presentation.

A final few points for lecturers aiming at the highest quality, colour correct images:

A high degree of control is needed to obtain images with perfect colour recording and
saturation. This includes controlling the input of colour into the camera, using a grey card
or similar tool to manage the initial image capture. Your monitor should be calibrated so
that the picture you see is exactly what the camera recorded. This may mean a new, better
quality monitor of course. Finally, if you are going to print out any pictures then your
printer probably needs profiling, too, to the brand and type of printing paper you are
using.

Attention to these details can lead to colour accuracy which far exceeds that obtainable
in the past.

Appendix J: Requirements of digital picture libraries

Here is some extra information. If you are taking many plant pictures and have ambitions
that they will be used nationally in digital slide libraries or commercial stock libraries,
you may well be interested in this appendix.

Digital image libraries, such as the HPS Image Library, require pictures which are used
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if the projector is tilted up in an
attempt to fill the screen — the
picture will be wider along the top
edge and narrower along the
bottom, as in fig 1.

Most digital projectors are now
able to correct this distortion by
digitally reshaping the whole
image to make a perfectly squared
off picture on the screen, as in fig.
2. This means that the screen can
be lifted up higher than usual, and
the projector stand can be lower,
and hence rather more stable. This
should enable the people at the
back of the hall to have a better
view. The adjustment regulation is
an integral part of the projector
controls and is called a keystone
correction. It can be used
whenever the projector is set up
and can easily be customised in a
few moments before your lecture
to suit the projection situation. It is
well worth doing, but practise this
at home first, with the projector
manual in your hand!

2 Screens

If you are investing in a new projector, please also examine your existing screen, and
perhaps consider changing it for one with a new, up-to-date surface. The difference it will
make will almost certainly be worth the cost. An old screen will probably have become
soiled and will inevitably have curled up at the edges and actually be not quite flat. A new,
clean, bright screen, big enough for any possible future higher quality projection, would
be advisable.

An extra point to be aware of is that a screen at the end of a hall is often up on a stage.
There are often small draughts in this area and screens sometimes move around in these
conditions. It is easy to weigh down or tie back the bottom of the screen to obviate this
problem.

N
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3 Digital photographs

Format

Digital projectors show pictures only in the horizontal landscape format, not in the
vertical portrait format. You should therefore take photographs in landscape format
whenever possible. Vertical picture images have to be either cropped, which will
eliminate parts of the top or bottom of the frame, or else resized (see Appendices D and
E). For lecturing purposes it is far easier simply to take horizontal pictures whenever
possible. Editors of newsletters and magazines often prefer an upright portrait format. If
having your photographs in print is also in your mind, take two photographs of each
subject, one landscape and one portrait. You will then have two strings to your bow, and
not need to change the height/width ratio formats.

Size/resolution of digital photographs

At the moment, standard projectors use an input format for their pictures which is 1024
pixels wide by 768 pixels high. They use a pixel density of 72 dpi (72 dots per inch) and
this is colloquially called the XGA resolution. Many photographers may be surprised at
this apparently low pixel density, but in practice an excellent projected picture will result.
Because nearly all cameras will take pictures at around this image size, it is perhaps
tempting to think of using this as the standard for your photography. But there are other
factors which make it inadvisable.

It is always better to take photographs at the highest reasonable quality of which your
camera is capable. Image quality includes colour saturation, and the best, subtle colours
are only captured at a high pixel density. If you are going to print your photographs on
paper they will always need that high quality to be satisfactory. Another reason for taking
high-resolution photographs is that digital images can be cropped to place the subject in
a different position to enhance the impact of the final picture. Although you may not want
to do this at the beginning, it is very frustrating to decide at a later date to improve a
picture, and then find the original isn’t of sufficiently high quality to be able to do so. You
will always end up with a better image by making a high quality picture smaller than by
taking the picture at a minimal quality in the first place. The cost of storing larger size
images in a computer drive is now quite low. (See Appendix H for further information on
cameras.)

Size of photographs for projection

Professional projectors, used in business and at major national conference centres, now
use higher pixel density images. These standards are beginning to filter down to our
amateur market. There are several new formats and the one we might be concerned with
is called the SXGA+ resolution format: it is 1400 pixels wide by 1050 pixels high, and
will probably become the standard higher quality projection format in future. Already
some camera clubs are starting to buy these new machines. Fortunately these projectors
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Next return to the top menu bar, go to Select > Deselect and you have completed a
highlighted picture.

To use this type of highlighting to the very best effect you should the use the three picture
sequence as described in part 10 for title slides. You would show the highlighted image
you have prepared between two untouched pictures. There should be in a dissolve
succession, with a pause on the highlighted picture to clarify the plant or plants involved.
Of course your title can be added to this highlighted image too. If you use the ‘grey out’
method described above, then you will very likely have an ideal partly grey background
for any text you might wish to add. Figs 12, 13 and 14 illustrate this technique.

Appendix I Camera requirements: a brief explanation

This appendix is not concerned with photography itself, but it is worthwhile making a few
comments on the picture quality required for projection.

Many people have commented that digital photographs are not as good as 35mm film
camera pictures. This is both true and not true. Film cameras produce an image which is
usually 36mm by 24mm (864 sq mm). Popular, small, compact digital cameras often have
a sensor which is around 12mm by 14mm, which is 168 sq mm. Small sensors are rarely
over 250sq mm. You will see that there will almost certainly be far less sensor surface and
therefore less information can be recorded than with a film camera.

Manufacturers have found that squeezing more and more pixels into that small sensor
size will sell more cameras, and that lots of pixels have a supposed ‘wow’ factor. Camera
salespeople will nearly always emphasise the total pixels to indicate high quality. New
technology does indeed mean that a ten-megapixel camera is almost certainly better than
a six-megapixel camera, but there is still a major disparity compared to film cameras
when the sensor is so small.

Current digital single lens reflex (SLR) cameras are more expensive, having sensors of
around 24mm by 16 mm (384 sq mm). With the latest high megapixel density they are
capable of recording a quality equal to and often rather better than film. The lenses of
these larger SLR digital cameras are also vastly superior compared with compact
cameras: they have more lens elements and these produce a professional optical quality.
The internal SLR camera computing systems are also far better at reproducing images.
Another factor is that they have much larger buffer memories in their computer hardware,
which means that they start to save a picture almost instantly after the exposure release
button is pressed. There is no waiting for the image to be downloaded onto the main
recording card. A number of full frame, much more expensive, 36mm by 24mm sensor
size cameras are now coming on to the market, and these are without question superior
to film of equivalent size in almost all respects.
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Open your selected image in Photoshop, making sure that under the Window menu the tools
palette is open.

On the tools palette find the lasso tool (not the alternative polygonal or magnetic tool
variations). Click on this icon and the mouse cursor will turn into a miniature lasso.
Using the heel of the lasso, carefully draw a circuit line around the subject you wish to
highlight, keeping the left mouse button depressed. When you have completed the shape
you want and have joined up with the start of your circuit, release the mouse button and
it will stay a selected area. If the selection you have made is not to your liking, go to the
top menu bar and click on deselect and try again; or click on the history tab at the top right
of your screen, which will list the action(s) you’ve taken, and any action you’d like to
undo you can drag and drop into the recycle dustbin in the tab immediately below. You
may need several attempts to get this perfect.

You can also soften the selection edge, by
putting in a number such as 40 into the feather
box, which is in the options toolbar just above
| your picture. Experiment with different
numbers to obtain the effect you prefer.

Next go into the select menu on the top menu
bar and choose inverse.

® This will select the part of the image which you
want the audience to ignore. You now have
many options to change the texture of this area.

I suggest as a start that you use the following
¥ simple method:

On the top menu bar choose enhance, and then
+ select brightness/contrast .

= A control box will then appear. Tick the small
. preview box and then adjust just the contrast
slider control. Slide it to the left, and your
selected area will then ‘grey out’ and gradually
lose colour saturation. Move the slider around
until you have obtained the effect you are
seeking. Press OK.

A good alternative is to go into filter on the top
menu bar:

| Filter > Noise > Add noise will bring up a
control box, and you can create a ‘fuzziness’ in

Figs 12,13 & 14

the background of your picture. A combination
of a little of both these effects is usually
effective.
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are fully compatible with our present lower pixel density images. In other words, if you
show images of the present 1024 X 768 standard through the SXGA+ projectors they will
project perfectly, but at the lower projection resolution which we are used to now. The
answer is probably to modify your digital images to the current lower pixel density for
the moment, but DON'T throw away your original master images. If required in the
future, you could easily make an alternative new set of pictures to the new larger pixel
size and ratio. (Major conference centres now use projectors that can use even higher
pixel density image standards projecting on to very large screens, but that is outside our
remit here.)

Taking best quality digital photographs

Many lecturers use photographs taken with unsupported cameras and the resulting
pictures are reasonable when looked at on a small computer screen. However, when
projected and viewed from the back of a hall, these images are usually rather poor and
blurred. Because most speakers don’t look critically at their own projected pictures from
a seven to ten metre distance they can be oblivious to the problem and even think that
their pictures are of exhibition quality. Audiences are also conditioned to viewing images
that are less than perfect and accept them, until they see the difference!

Serious lecturers should use first class, single lens reflex cameras and also use some form
of support for their cameras. Tripods, monopods or even just a chair back are absolutely
essential to good picture quality. A cable shutter release and some knowledge of colour
space, white balance and image capture formats are essential to produce first class
images. Very small, handheld digital cameras are just not good enough quality for top
class presentations, though they may well be fine for other uses.

It is worth mentioning here that pictures used for reproduction or high quality printing
should be taken with the colour space set to Adobe RGB if your camera has this feature.
The alternative sRGB colour space will record with a slightly reduced palette of colours,
and this constriction may be important in recording the most accurate colours in flower
photography. (sRGB originated for making pictures for websites where a smaller colour
range is usually quite sufficient.)

The better digital cameras can be adjusted so that the exposure and colour saturation
result in a photograph which can be superior to film. Even hard-to-replicate, delicate blue
flowers can now be recorded with a fully truthful colour if the white balance camera
controls are used properly.

Picture quality can be set in all cameras. If you are an experienced photographer and have
the necessary provision in your camera, then you may well be using RAW image capture
which gives the very best quality image. TIFF recorded images are also of the highest
quality. These two camera settings will make images which are not subject to any
compression by the mini computer chip in the camera. JPEG images will be fine for our
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use, especially if the highest quality JPEG is set in the camera. All JPEG images are,
however, compressed when saved in the camera’s memory system, and again in the
computer. (Compression makes the digital file smaller by evening out colour variations —
there may well be no discernable difference in a picture taken at the highest JPEG setting,
but all JPEG images are compressed to some degree and therefore have less information
and result in a lower quality image.) The most basic JPEG picture will be even more
compressed so that there is even less information in the picture — the image picture file is
much smaller, hence many more pictures can be stored in the camera memory card, but
at the cost of quality.

This will probably not be a factor in most of our garden photography, but it is worth
bearing in mind that the fewer adjustments-save-adjustments-save sequences that there
are, the better the final picture will be. Professional photographers usually use TIFF
images to work on in a computer. They can be opened and closed any number of times
without any loss of quality and they then convert finally to JPEG.

4 Setting up for a lecture

Most speakers will use a short 2m cable to connect their laptop to the projector. This
usually connects to the monitor (or VGA) port on the computer and the RGB in port on
the projector. The cable is commonly called an RGB signal cable. Occasionally it is
necessary to toggle one of the function keys on the top row of the keyboard to operate the
connection. This may well be the F7 key (possibly plus the Fn key too), but can vary
according to the laptop make, so you may have to read the instruction book.

However, some lecturers now like to have their laptop not adjacent to the projector, which
is likely to be in the middle of the hall, but instead on a small table in the front of the hall
near the screen. Then they can speak facing the audience and are able to glance down and
see the laptop screen too, with the great advantage of being able to view the picture being
projected without constantly turning round to check on the big screen. To achieve this
layout requires a longer cable to link the projector in the middle of the room to the laptop
adjacent to the lecturer and screen. Some halls are already wired for this, but alternatively
a 10m-length cable can be used in a small to medium hall. A low voltage is used in these
cables and in longer lengths this inevitably results in a volt/power drop. Occasionally this
can cause a problem when the laptop and projector, although each is working properly
separately, simply will not work in tandem. This is because the laptop voltage output is
not quite enough to operate the projector. Many of the latest projectors can accept a
memory stick or card directly into the projector itself so this extra cabling may not be
necessary. However the speaker may then not have the benefit of direct viewing on his or
her laptop screen, or have the possibility of showing any other image during that
presentation.

The solution is first of all to have your laptop battery fully charged well before the
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Remember that you are working with thumbnail reproductions of the proper pictures, not
the masters. Apart from the renumbering you are not altering anything else about the
images. Any resizing or other alterations must be carried out separately.

Appendix G Adding text to picture images and making text picture images

First create your text in Microsoft Word, then highlight it and copy it into the clipboard memory
using the normal Control+C command.

Next open up and create a blank image in Photoshop. This could be perhaps white, or better
still a pale grey, as detailed in appendix B. With the tools palette open select the type tool
icon from that toolbox. The mouse cursor will then change to a type tool and you can
move it to an appropriate place on your new blank image and choose the best position for
the text to start. Next left-click your mouse to fix the cursor on the screen, use the Word
command for paste, Control+V, and the text will be pasted into your image. If the text is
not the right size, you can change it directly in Photoshop by highlighting it and changing it
in the options toolbar.

To consolidate this you have to go into ‘Layer’ on the top menu bar and select ‘Merge
Layers’ this will bind the text onto the plain background .

H Highlighting parts of pictures

Highlighting a particular area of a projected image can be an important communication
between the lecturer and audience. This is particularly so when an image is shown which
contains parts which could be confusing for some members of the audience. A typical
example would be a mixed herbaceous border and the discussion of different plants, one
or several at a time.

Highlighting is most commonly used for this purpose inversely. That is to say, the subject
area you are concentrating attention on is not highlighted itself, but is selected from the
background and is then kept intact. It is the background part which is then separately
selected and is digitally manipulated so that, for instance, it is desaturated of colour. The
coloured subject area will then stand out significantly from this background and the
audience will not be muddled by the surroundings.

Using Photoshop it is easy to draw a simple line around the selected part of an image with
the lasso tool. This will designate an area, and is usually enough for this purpose. Other
more sophisticated methods are available in the programme but they require a greater
knowledge of the software.

Again I suggest that you try this out first on a discarded image to familiarise yourself with
the procedure. These are the steps:
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Go back to the top menu bar and select File > Save all. The new images will then be
saved over the originals and the numbers will have lost their ‘stars’.

Finally close the programme and check back to your original image file that they have all
been all been changed to the new dimensions.

Appendix F: Thumbnails and contact prints

Using the standard Windows Explorer programme, which is on every PC, you can open a
folder of pictures as thumbnails. Remember that this should be a duplicated folder not the
original.

To do this open your selected folder, click on the view menu and select thumbnails. This
will then bring up all the images as small postage-stamp-size thumbnail pictures. By
clicking on any image and holding down your mouse button you can drag and move the
thumbnail around the screen using the mouse with the left button pressed down. You can
then reposition it between any other images. Gradually you can recompose the whole
picture sequence, and delete single or multiple pictures if you wish. Additional pictures
from other files can also be dragged and dropped into this working folder.

When you have re-ordered the pictures like this, you must remember to rename or rather
renumber every single picture (see Section 8), otherwise when you close down the folder
your computer will ‘forget’ the new sequence. This happens because you have only been
moving around a screen copy of the pictures, and not the real pictures themselves. The
real pictures themselves are not locked into permanent position until they have been
properly renumbered. Once they have been renumbered you can save the folder and the
new arrangement will be consolidated.

Printing out the thumbnails

If you wish you can now print out these re-ordered and renumbered pictures.

Photoshop will allow you to print out your images in various sizes and on alternative size
printing papers. To do this, prepare your images in a single folder — this is your source
file.

Then go to File> Automate > Contact Sheet 11

Beneath the source directory a dialogue box will appear. Click on the choose button,
select your source folder and click OK again.

Next choose the document (i.e. paper) size you are going to print out on. This could well
perhaps be 8x10 paper at say 72 pixels/inch, RGB colour.

Finally you can select the number of images you want printed on that page by choosing the
number of columns and rows to make up the number. A helpful guide is given on the right of
this dialogue box, where a graphic window display shows the picture layout. This changes as
you change the values of rows and columns, so that you get a good idea of the result. When
you are satisfied, click OK. The page of thumbnails will appear, ready to print.
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presentation, and then to connect up the laptop to the charger again before plugging it into
the projector. It cannot be overemphasised that the laptop must be connected to its
transformer/charger, and be actively in charging mode during the show. For ultimate
security, a lecturer should really provide his or her own longer cable which has been
checked with the laptop being used. To avoid any possibility of a mismatch, the laptop,
cable and projector must be checked when they are all connected up, before each
presentation.

If you are buying a new laptop, if at all possible you should test it with your cable and
projector before purchase. Otherwise, ensure that it can be exchanged for another model
if it is not compatible with your projection equipment.

All cables should be carefully coiled, and stored in a bag or box, and not thrown in a
jumble into the back of a car! The multiple wires and connections in these cables are
actually quite delicate, and any twisting of the cables may damage them.

5 Converting film-slide photographs to digital photograph files
(Slide reproduction)

Now we come to another topic altogether. A large collection of beautiful film-slides is
probably the greatest disincentive to making the change to digital projection. We all
have our favourite film-slide pictures and some are unrepeatable, especially those taken
on travels abroad. There is frequently a conflict between being able to use these old
favourites and buying a new digital camera with the promise of achieving modern and
exciting images. Indeed, continuing to use these older, film-based slides may well
actually prevent an adventurous foray into improved sequences, showing fresh plants
and illustrating new thoughts and ideas on current progress and recent horticultural
developments.

However, your older film-slides can be transferred to a digital format. Many flat-bed
standard office-type scanners now have gadgets which will accept a film-slide and scan
it into a computer; these will certainly produce an image which is of a fair standard
when viewed on a computer screen, but it will rarely be good enough for a projected
image in a hall.

Dedicated scanners for film-slide conversion can cost from £100 upwards and will
produce better images. For around £500 upwards an excellent high-grade instrument
can be bought. Some camera clubs are now buying them to share between members.
However the actual transfer sequence can be a time consuming exercise. Old film-slides
are frequently dusty and must be cleaned with a very fine brush or blower. If they have
been mounted between plastic or glass, then ideally the film itself should be removed
for cleaning before the scanning (then possibly be replaced afterwards as a back up!).

www.hardy-plant.org.uk 11 The Hardy Plant Society ‘%



If you have only a relatively few film-slides to be transferred to digital images, probably
the best option is to consider a ‘slide to digital’ bureau. A local photographic printing shop
may do this, or alternatively put ‘slide to digital’ into Google to find a host of sources.
Although you can get a film-slide transferred for around 30p, a better quality higher
resolution transfer will probably cost nearer to £1. These transferred digital images will
be very reasonable for most projection and lecturing. Editors of horticultural magazines
and professional photographers, for example in the fashion industry, can spend £12 or
more per image for faultless, larger format, digital picture files from a superior copying
device known as a drum scanner. This is usually not necessary for use in a digital
projector.

Another option is a film-slide-copying adaptor which fits in front of a digital camera with
a close up lens. Photographs are taken using either natural daylight or flash. If you have
a first class SLR camera (see Appendix I) and close up lens then the resultant images can
be very reasonable, but the colour balance will nearly always need to be adjusted using a
software programme on your computer.

However transferred pictures like this are rarely perfect, and they often need some fine-
tuning of colour to blend in with the rest of the sequence. In the past we have accepted
some pictures which have been imperfect because film images, especially film-slide
pictures, cannot easily be adjusted, and we have simply had to accept some which are less
than ideal. Modern digital photographs, taken with a first class camera and lens, are now
more faithful than film to the truth of the original subject. Exposure and colour saturation
can be of the very highest quality, and of course you can check the quality of your
photographs immediately. The old film-slide images may now on reflection appear too
light, or too dark, or perhaps have imperfect colour rendering. Indeed they have often
faded or deteriorated with time. We have all seen slide projections of tired and washed
out film-slides. Modern software can very often largely correct many defects in these
transferred pictures and superior images can be produced. Also digital images never fade.

If you go through your original film-slide collection carefully you will probably find that,
apart from photographs of foreign travel, you may need to have only a relatively few
transferred to digital images. After all, your new picture images are much more apposite
to your current thoughts about your subject, and they may well have overtaken much of
your historical collection.

6 Adjusting digital photographs

Many photographs, from a scanner or other reproduction system, or direct from a digital
camera, can be improved by some simple enhancement. By this I do not mean digital
manipulation to alter the integral sense of the image — I am talking about minor
adjustments, perhaps of colour or contrast, or minor blurring of the background, to
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In the image size area, tick the convert file type and select JPEG

Tick convert box, and put in Width: 1024 , Height: 768 and resolution 72 dpi

Leave file renaming unless you are an experienced computer user.

In output options navigate to your new empty destination folder, and click OK.

Now click on the main (top RHS) OK and the images will be rapidly resized to the correct
pixel density and size for presentation; they will appear in your new destination folder.

Microsoft Office Picture Manager, which may well be in your machine, is also suitable for this
procedure, and details are in Appendix E. A number of other free programmes will do the
job, and I would again recommend Irfan View as an admirable working programme which
will carry out batch conversions too. The help files in both programmes (look up resize)
will help you carry out these conversions.

There is a dedicated small programme available from Microsoft from their online software
downloads under the Powertoy set of free add-ons. It adds a resize extra part to the menu
options. Once downloaded into your computer it will work on a single picture or group
of images in a folder. The working method is to right-click your mouse on the image or
image file. The word resize will appear in the selection box menu. Select this option and
a simple resizing sequence can be followed. (This is not available for the Vista operating
system)

Appendix E  Resizing the image with Microsoft Office Picture Manager

(This programme is found in the Microsoft Office suite under Microsoft Office Tools and is on most
PCs — so it’s free and needs no downloading.)

Make up your folder of all the images you wish to use in your presentation, again make
sure all the images are JPEG and in landscape format. Copy and rename the copy, save
it and then use this duplicate to use as your working source folder. The master original
folder is therefore untouched.

Open Microsoft Office Picture Manager

Then File > Add picture shortcuts — this opens selection box — and navigate to your copy
working file as above and click add. All the file pictures will be added to the main
window.

Under Edit menu > select all and all images will be highlighted.

Then in the toolbar click > Edit Pictures, the Edit Pictures menu will appear in a window
to the right of your selected images.

Then in near the bottom of this new right hand window > Change Picture Size > Resize.
Now select > predetermined width and height > Select Document (large) and tick the
small arrow just to the right. (This will bring up the standard you require of 1024 X 768
pixels, and is confirmed in the size summary setting at the bottom of the window)

Click OK at the bottom of the window and all pictures will then be resized and the image
numbers will be starred.
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Move this to part of the image and, pressing the left mouse button, drag the new cursor
obliquely across the image.

A new highlighted rectangle will appear. This is your possible crop selection. The cursor
will change to a series of different small arrows if you pass it around the newly selected
picture.

By left-clicking the mouse and dragging these arrows at the control boxes at the corners
of the image or in the middle of the sides you can extend or contract the image. (You can
rotate it, too, by dragging the curved arrows which appear near the corners; the image will
rotate around the small mark in the centre of the picture. You can move the centre by
dragging the mark with the mouse, then clicking on any tool in the toolbox to fix it in
place.)

Press your escape button to revert back to the original image, or enter or return to make
the crop. This needs some experiment to become familiar with the sequence, but is not
difficult to master.

If you have made this crop and you don’t like it you can at this stage go into edit on the
top menu bar and select undo crop, and you will then go back to your original image for
another attempt.

Your picture is now cropped and resized, all ready for projection.
Appendix D: Resizing the Image

You need to ensure that every image you are going to use to the 1024x 768 pixel density
and ratio. If they are not already in this format, it is quite possible to apply the crop tool
(as in Appendix C) to every image in your sequence to resize the picture, by applying the
crop not to a section of the image, but by cropping right to the outside of the image, which
could well be to the whole of the frame.

Resizing a large number of images can be done in bulk. Remember that all the pictures
must already be in the landscape format, and once again don’t forget to perform this on
a duplicated folder of your selected image files, just in case you don’t get it right the first
time!

First of all create a folder of all the pictures you are going to resize. This will be your
‘source’ file. To avoid confusion here I would suggest not placing your resized images
back into this same folder after processing. Create a second empty ‘destination’ folder,
perhaps on your desktop to receive these pictures.

This is the method in Photoshop:

Go to File > Automate > Batch

The batch conversion window will open up:

Click on the source box and navigate to your source folder, then click OK.
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improve the overall picture. This can often be similar to a botanical artist subtly
improving their view of a plant by excluding or blurring extraneous foliage and
enhancing the sharpness and possibly colouring of their chosen main feature.

If you are going to do this, then it is imperative that the folder containing the master set
of images you have made for the presentation is copied and duplicated at least once, and
preferably twice, before you start on any of this work. Using one of these duplicated
folders, any and all the adjustments are then made with safety, so that if by any mischance
a wrong button is pressed (despite extreme care it happens to us all, frequently) you can
always go back to your master folder or that spare duplicate folder and retrieve the
situation.

Always rename the latest version of a folder or a file as you are working on it, so that you
don’t get into a muddle with possible multiple versions. Keep a log of all the adjustments
you make.

Keeping to a horticultural context, minor blurring of backgrounds and removal of
offensive twigs and foliage may possibly be a contentious issue. In the end it is a personal
decision as to whether to adjust or not. My personal opinion is that minor adjustments are
acceptable if they improve the reality and quality of the image. You may feel that in
exceptional cases it is reasonable to state explicitly that changes have been made. It is
clearly wrong to mislead or falsify, for example to pass off a garden plant as one taken in
the wild, or to change the colour or form of the image to turn one cultivar into another.

One of the chief aims of an illustrated lecture is to augment and clarify the spoken word
by means of photographs, and vice versa. In order to do this the pictures should be as pin
sharp as possible, and with adequate colour saturation. Thin, washed out pictures, will
never be seen well at a distance. It is so easy to look at pictures on your computer screen
and think they are beautifully sharp and of exhibition winning quality, but when they are
projected and seen from a distance they are often blurred and really rather poor. This
problem is magnified when several images are placed together on one slide. It is a small
technical achievement to make up a slide having, for instance, a bud, flower and seed
head all side by side — it can be admired on the monitor at home, but at a distance the
individual quality may well not be good enough.

Many picture image-processing programmes such as Photostory (a free download from
Microsoft) or Picasa3 (a free download from Google) can carry out many corrections. The best
programmes, with more advanced features, are the well-known Photoshop Elements, or Paint shop
Pro, which have to be paid for. The larger programme, Photoshop itself, is a more elaborate
programme for professional, or very dedicated amateur, use.

All these programmes can crop or resize the image for the exact measurements required
by the projector (1024 X 768 at 72 dpi). In fact most projectors, in conjunction with their
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controlling laptop, will accept any image size and then immediately readjust the size ‘on
the fly’. This can often work satisfactorily with one or two images, but it is one of the
more common reasons for a problem in a digital projection sequence. Correction of the
size should be done properly before assembling the images for the lecture. This is because
multiple size readjustments one after the other can lead to a build up of memory deficit
in the laptop or projector. This can not only slow down the presentation but can even lead
to a ‘freeze’. (See Appendices C, D and E for some suggestions for cropping and
resizing.)

At this stage all your images should also be converted to the JPEG format if they are not
already. This is because digital projectors can only handle JPEG images. This can

be done in a number of programmes, and can usually be done when resizing the images.
(Photoshop may well be used, but it may not work if you have a new camera and a rather old
version of Photoshop). Irfan View is a free download programme, useful all round, and has free
conversion plug-in extras for almost all makes of cameras and their different types of
RAW files. Some of the latest cameras need these new plug-in interpreters in order to be
read by the computer software.

7 Making up the lecture

You should by now have selected the images you are going to use for the lecture and have
put copies of them all into a picture folder. The folder should be carefully duplicated, and
at least one copy kept as a back up, with a different name. Don’t be afraid of copying
images, and working on a duplicate — unlike film copying, each replication is an exact
reproduction of the original. Neither is there any deterioration or loss of quality of any
kind — changes only occur when adjustments are made on a picture in the JPEG format.
Of course most of these multiple back-up folders and image files can be erased once
you’ve completely prepared the lecture.

The duplicate picture files in the folder can be worked on further without risk of losing
all the previous effort. This is what could be regarded as a semi-final selection of images
— new pictures can be added and some can be removed as necessary, but in the main the
lecture will not be radically changed. Now is the time to start to consolidate your choice
and create the picture image sequence.

In the days of preparing for a film-slide presentation, it was common to collect all the
film-slides together, then lay out the projected sequence, either singly or in piles, perhaps
on a spare table or tray. When you start to prepare a digital presentation it may be quite
difficult at first to plan a lecture on a computer screen. It will be necessary to convert your
images to small thumbnails, perhaps as small as a couple of postage stamps, which can
then be moved round the screen into your selected order. This is not so dissimilar to the
solitaire card game found on most computers!
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Once you have made one grey, and one black slide, they can be duplicated on your
desktop using copy and paste, and then used for the purposes described here in any
number of presentations.

If you want to make a coloured slide proceed as above, but this time tick the colorize box
in the Hugh/Saturation control box. Instead of moving only the lightness bottom slider,
move the hue and saturation sliders around as well, experimenting to obtain the colour
you wish to achieve.

Appendix C: Cropping the Image

Many flower and other pictures are very creative and imaginative in their original form.
However it may well be that an even superior picture will result by selecting part of an
image. This is called a crop. Typically cropping can be used to single out a particular
flower or plant or perhaps to just eliminate an unwanted section of the picture. Photoshop
has a crop tool which enables you to do this. Always do this on a copy of your original,
high quality image, so that you are cropping from the initial maximum pixel density,
not from a picture you have already made smaller. Once again of course carry this out
on a duplicated image, not your master photograph.

Even more useful is that in Photoshop the tool can be set to crop to the 1024 X 768 ratio at
72 pixels per inch so that cropping and resizing can be carried out in one go. This will
then make that particular single image cropped, resized and ready for projection.

(I would suggest that you carry out a few trial crops on a spare image first of all to gain
confidence.)

Open the image you are going to work on in Photoshop. To check you have the options
toolbar and the tools palette open follow the details below:

Select ‘window’ on main toolbar, and on the drop down menu select ‘show fools’ and also
select ‘show options’. Click on each item, they could be already displayed, depending on
how you last used Photoshop. If not, by clicking on these items in the Windows menu you can
show them if they are not visible.

You can move the tools palette (a box with icons representing fools which you can use to
change your images — like a toolbox) to the side of the main picture screen and run your
mouse cursor over each picture in the palette to find the use of each unit.

Click on the crop tool.

The options bar (at the top of the screen) will then display the crop tool with four
windows adjacent.

Enter: Width: 1024px Height: 768px and Resolution: 72

Make sure that in the fourth box the resolution is set to ‘pixels/inch’, not ‘pixels/cm’.
Now you will find that when you move your mouse cursor across your picture you have
a boxed/crossed cursor instead of the usual arrow.
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fine tune the size of the image. Click anywhere
outside the picture to de-activate the control
boxes.

Finally, you have to merge the two images
together: click on the layers menu and then click
on the merge command. You will then have a
new, properly proportioned picture, with discreet
left and right plain borders which should be very
acceptable (See Figs 9, 10 and 11). Save your
new combined image with a different
name/number!

Appendix B Making a grey or black slide
with Photoshop

Open Photoshop >File> New> then in the box
which comes up you have to size up your new
image. This should be Width 1024 pixels Height

768 pixels, and the resolution at 72 pixels/inch
(not pixels/cm). If the right hand box is not
showing ‘pixels/inch’, click on the downward
arrow beside it to get the drop-down menu and
click on ‘pixels/inch’ there. In the Mode box
choose RGB colour, and in the Contents box
choose white.

Press OK, and the new white picture you have
made will come up onto the screen.

You can now colour this picture.

Go into the top menu bar and choose-

Figs 9, 10 & ||

Enhance>Colour >Hue/Saturation

(This may be Image>Adjustments>Hue/ Saturation in other Photoshop versions)

Up will come the Hue/Saturation control box. Make sure Edit box is set to master. Tick
the preview box, but leave the colorize box blank

Move the bottom slider only — Lightness — and slide to the left. The white ‘picture’ you
have made will then turn through shades of grey to black. Choose the shade you feel is
the most appropriate and click OK.

You now have to save this image.

Go to File> Save as > and in the control box navigate to where you want to save this new
image. Give it a name perhaps ‘ grey slide’. Make sure the format is JPEG. Click OK.
When the JPEG options box comes up put Image Options to High and leave the other
options alone. This all creates your grey image file.
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Some people prefer to carry out the first part of the selection process with actual prints
that they can move around. This is where printed out thumbnails can be useful. Many
programmes can be used to print out the thumbnails and they are often called contacts
just like a page of contact film prints. If you print a contacts sheet, the thumbnail pictures
can be cut up and stuck in order on to a large piece of card or paper. Blanks can be added
to represent the pictures that you plan to add later. You can make up your whole lecture
very much like a story-board used widely in the TV and film worlds. See Appendix F for
more information on thumbnails and contact prints.

8 The presentation process/programme

The next stage is to think about how you are going to actually show your pictures. Which
programme are you going to use? It is quite possible to give a whole lecture using the
software you are already using to select and view your pictures.

In Windows Explorer you can double click the images in the thumbnail view to bring up a
single enlarged view of each picture. Click the start slide show icon beneath and the
pictures will show as a full-screen slideshow. If you move your mouse cursor, a control
panel will open on the top right of the screen. You can then control the show — forwards,
back, hold or leave it on an automatic slow-play sequence.

Several other programmes such as Microsoft Office Picture Manager (usually part of Microsoft Works)
or Irfan View, also have a slide show facility. Any of these may well be fine for home viewing
or checking your images, but are not reliable enough for a presentation to an audience.

In order to create a more permanent and professional presentation, perhaps with added
details, here are some suggestions.

You must consolidate the order that the slides are shown by changing all the existing
picture numbers and/or names to a new numbering system. Pictures which have been
sorted for instance in Windows Explorer, will not retain that image order if the folder is closed
down and reopened again. On reopening the folder it will usually be automatically
refreshed and the original order reinstated. The answer is to consolidate your revised
order by renumbering the images into a new sequence.

You may already have renumbered the pictures to make contact prints, but there are more
important reasons to do so. When your pictures are projected there must be no possibility
of any muddle over the projection order. If you have pictures from several sources, such as
from a scanner, a camera, pictures from another camera, or pictures taken at different times
or on different cards on the same camera, then the existing numbering is likely to be a
hotchpotch of different letters and digits. When the final projection takes place, the laptop
and projector work best if they select the pictures one after the other from a sequenced file.
They won’t have to jump from one place to another to pick out the next selection.
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Renumbering may appear rather tedious but is essential for any longer presentation. To make
a new numbering sequence you need to use the rename option for each image. You do this
by selecting each picture in turn, with your mouse, right clicking the image, to obtain the
right click menu, and then selecting rename. The name box is then highlighted and you can
type in your new picture number. An even quicker method on most computers is to select the
picture and then just press the F2 button, if you have one on your keyboard. The existing
picture title will be highlighted, and you can immediately type in a new image number.

Beware — computers don’t count like people!

I suggest that you start your numbering system at the number 001, then the first three slides
will now be 001, 002, and 003. The reason for this is that computers work on a binary
system and so they can behave in what seems to mere humans a bizarre way with numbers
in sequences. They can select a picture numbered 1, and then they may next select not 2 but
the picture numbered 10 to be the next, and then perhaps 11 to follow on. A disaster! By
starting the sequence at 001 you can avoid this problem.

Another suggestion is that if you give several lectures you can also add a letter prefix to each
picture number, so that the series becomes 2001, a002 and then a003. You can call all the
pictures in your first lecture a001... etc., then when you set up a second lecture you can
number your pictures starting b001... etc. If all your lectures start with a different prefix,
then when running through or adjusting a lecture by copying or moving pictures from one
folder to another you will know at once which lecture you are in, and you’re far less likely
to get into a muddle. Lectures are frequently updated and changed as new pictures are
available, and versions may be made for different audiences and different time constraints.
This simple method can prevent many ‘lost’ pictures and consequent frustration.

Once your picture files have been renumbered, your lecture can still be adapted and changed
if you wish. You can eliminate a picture by deleting it and the picture sequence will just jump

to the next image as though nothing had happened. For example, if you delete the 31 st picture
in the sequence you will delete image @031, and the picture sequence will then run ...a030,
a032, a033... etc. Similarly, if you want to add a picture after say a124 then this can be
numbered with a suffix, for instance al24a, and by dropping this into the file it will
automatically appear between a124 and a125 and the sequence will be ...a124, a124a,
al125... etc. If you want to add three slides, then they could well be a124a, then a124b, and
finally a124c. When adding extra pictures you will almost certainly need to close down your
image files and the folder of files for a couple of seconds. When they are reopened the new
images will be automatically installed in their proper sequence. You can also change the
position of slides, renumbering each slide with its new number position. On my computer it
is necessary to enter the view menu and change from thumbnails to list or details and then
close the file. When the folder is next reopened and viewed as thumbnails again this
resequencing is incorporated — it doesn’t seem to work when keeping to the thumbnail view.

Of course if you have made umpteen numbering changes in a folder it could well be much
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Tick the Constrain Proportions
Leave the Document size box alone, except to change the Pixel Resolution to 72 pixels
per inch if there is another amount in there.

Now the important part:

In the main upper box (Pixel Dimensions) type in the Height first of all to 768 pixels. As
you do this the units for the Width will automatically change to the correct width value,
which keeps the aspect ratio correct — it is commonly around 570 pixels. Press the OK
button. You will now have a resized image which will fit into the correct projection
format, and also has the correct pixel density. (If the image is too big for the screen, click
on the magnifying glass tool and right-click over the image and use the drop down menu
to adjust the size of the screen image.)

However a small warning here, this picture will probably be fine for most projection
programmes and will usually correctly be centred for display. Depending on the viewing
software used later, there is still a possibility that this image will not be properly
positioned, but will be placed to the side of the screen not the centre.

In order to obviate any possibility of this happening, your new picture should ideally be
merged with a pre-made background. This is in the master landscape format, and then
there is no chance of any hiccup. In any case, if the picture is projected as it is, it is likely
that there will be a white space each side of it when it is projected. The sudden impact of
these white margins is not really conducive to a very smooth presentation. The creation
of a picture which has perhaps grey or black margins is a more professional method if you
have the time.

To create this merged image, first of all make a grey or black slide in Photoshop, as detailed
in Appendix B below. With this grey sl/ide up on the monitor, open up your new converted
picture, and make sure each image has the same percentage magnification. The
magnification percentage is on the small menu bar above every image on the Photoshop
screen, and may be in a small box on the lower left of the picture, depending on the
software version. With your cursor on the picture you wish to change, press the keyboard
Control+plus or Control+minus to make the pictures equal in size and small enough to
be approximately side by side.

Click on the rectangular marquee tool to select the whole picture, by clicking the tool on
to a corner of the image and sweeping it diagonally across to the other side.

Then find and use the move tool (move your cursor over the fool icons and their functions
will be shown in text, click on an icon to turn your cursor into that fool) then click again,
this time on your picture image, and keeping your left mouse button down carry this
resized picture image over the new grey or black blank slide. Centre its position, and
release your mouse button to drop the picture over the blank slide. The picture will be
surrounded by a fine dotted line with six control boxes which can be used as necessary to
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Appendices — please note.

To avoid the confusion of detailing the use of multiple software packages, the details of
software adjustments in the appendices below are all described using the photographic
editing software called Photoshop Elements. This is a moderately priced, excellent programme
used worldwide. There are a number of other editing programmes on the market such as
PaintShop Pro, and PhotoPlus. These programmes have similar tools to adjust images and these
work in a similar way to Photoshop Elements. Adobe Photoshop (54 is the big brother to Elements, and
is the major professional editing programme.

Used here, the name Photoshop means Photoshop Elements throughout. Several versions of this
programme have been issued over the years, and consequently the exact keystroke
sequence or other details below may not absolutely coincides with your version or the
latest upgraded edition. These will be very minor changes and if clarification is needed
you can look up the help file. (Top right menu on the Photoshop toolbar) You should always
have the options toolbar, and the tools palette open in Photoshop. Check this in your
programme manual, help from the menu bar, or the notes in appendix C.

Appendix A: Portrait to landscape conversion

The standard projection format to use is 1024 pixels across and 768 pixels vertical. If you
are showing a picture of an upright object, such as a tree, and only have a vertical format
picture, then some adjustments need to be made. This is because the height/width ratio is
wrong, and indeed probably reversed. What happens if you try to show it without any
adjustment will vary depending on the programme you’re using. Sometimes this portrait
shaped is resized to a height of 768 vertical pixels, all correctly. But occasionally the
resulting image is squeezed to the left side of the screen, which looks odd. The worst
scenario is that the top and bottom of the image is simply chopped off! Just reshaping
your vertically taken portrait format to the landscape format you need could even result
in a grossly distorted fat picture!

By far the best solution is to properly resize your picture to the required projection
dimensions. Beware, though, that you will be ending up with a smaller size picture with
fewer pixels, and the image quality may be reduced. Changing to landscape format is
very easily carried out in Photoshop.

Remember of course to use a duplicated image to do this, not your master picture.

This is the procedure for a single picture:

Use File>Open to open up your portrait aspect picture
Choose Image >Resize>Image size

The Image Size conversion box will appear.

At the bottom tick the Resample box and set it to Bicubic.
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better to save your amended folder, renumbering the whole sequence perhaps using a new
letter prefix. If you have an idea in advance that you may well be going to change a part or
parts of your lecture, you can always leave a gap of a few spaces in your numbering at
regular intervals or just at any critical places, so that further pictures can be dropped in. This
may allow some leeway and help avoid having to do a total renumbering.

9 More picture preparation

Computers allow us to do so much more than just project one picture after the other, and
here are some hints to enhance that straight show of pictures and to make the presentation
much more professional.

My first suggestion is to make an all black slide (image) to be shown at the beginning and end
of your lecture — it will be the first and last picture projected in your actual lecture sequence.
This means that the projector can be set up and switched on well before the start of the lecture.
You can use a separate chosen image, probably not in your lecture sequence at all, to focus
and set up the projector with the screen, and make the keystone corrections (section 1). Then
you find your master lecture sequence folder and double click on it to open it up. The black
first slide will start your lecture. The screen will turn black, and all the equipment can be left
running. Probably few of the audience will be aware of it, but it does mean that at the
appropriate point, when the lights are dimmed and the picture sequence starts, there is no need
to move to the projector to switch it on and focus the first slide. You just press the button to
show the next picture, the one which actually starts your story sequence.

I would also suggest that at the end of a lecture you have as the next to last slide a neutral
coloured blank slide, say light grey. This is because nearly always someone has to get up
from the audience and stumble in the dark to switch on the hall lights, and some illumination
is useful. Then at the end use another black slide for the final projected image so that the
chairman won’t be giving you that great vote of thanks with a projector glaring into his or
her face! Black and grey pictures can easily be made in any of the image processing
programmes mentioned here. (See Appendix B for information on doing this in Photoshop.)

Another advantage is that a final black slide makes it appear that the projector has
switched off. It makes it less likely that someone will switch it off without warning,
before the power down sequence has been implemented. Though do watch out again for
someone helpfully pulling out the electric plug!

When the picture sequence is finally selected, the next thing is to duplicate the image
folder and keep a copy, perhaps on an external hard drive or memory stick, so that all your
hard work is doubly saved.

When you give your lecture you should always have your lecture presentation final folder
on your hard drive, in your laptop itself, and not played from a CD. This avoids the
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computer constantly accessing the CD during the lecture, another possible source of error.
Start by making the Keystone corrections (sectionl). Then find your master lecture
sequence folder and double click on it to open it up. The black first slide will start your
lecture. The screen will turn black, and all the equipment can be left running.

10 Plant name titles and other title slides

Some lecturers hand out lists of plant names, and this can be invaluable when many rare
and unusual plants are in the story. During the lecture, though, some members of the
audience may very well fail to pick up the name spoken by the lecturer and reading the
actual name on the picture itself is a marvellous aid for the audience and, indeed, maybe
to the speaker!

Always think of the audience near the back of the hall when making adding titles to your
slides. Unless the hall has raked seats, which is rather unusual, or the screen is at a high
level, the title should be at the top of the picture, not the bottom, so that it can be clearly
seen (not through a sea of heads). It is not at all difficult to add names to a picture using
the rype tool in Photoshop Elements.

I suggest you might try a little sophistication here, using a three picture sequence, which
can lift the presentation to a different level. To add a title this way, first make two
duplicate copies of the picture you are going to work on and rename the three identical
pictures with suffixes a, b and c. Images a and ¢ will be unchanged, while b will carry the
title. You will then be able to show the three pictures one after the other in an abc
sequence, pausing for a short time on picture b so that everyone can read the name. The
audience will have no idea at all that three pictures were used, but will see one picture,
with the title magically superimposed for a few moments. The advantage of doing this is
that the lettering, although at the top of the image, can sometimes obliterate or interfere
with the actual content of the picture and using three images allows the full picture to be
viewed again on the third image. A fade or dissolve between the three pictures is the ideal
way to show them (see section 14).

To make a titled slide, select picture b and open it in Photoshop or a similar programme,
select the fype tool from the toolbox (toolbox description is in Appendix C) and carefully
type in the plant name on top of the picture. Starting near the top left corner is probably
the best place. Use a black lettering colour if the background is light, or a white lettering
colour if the background is dark. (If the text doesn’t show up readily against all of a busy
background, you may prefer to set it against its own coloured label.) A sans serif typeface
like Arial is probably seen best from the back of the hall, rather than the serif font of
Times Roman. Some experimentation is usually needed to get the lettering the right size,
so that it is large enough to be easily read but does not dominate the whole picture. Arial
italic is a bit different from the Plant Finder lettering, so if that offends you go back to
Times Roman! Always use a larger rather than a smaller size of type so that it can easily
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If you are using PowerPoint then you can go back into the programme and retrieve a single
image. In any case having this all projected to the audience whilst you are searching for
the particular picture is not good practice. Remember you can nearly always turn off the
projected image via the laptop VGA port by pressing the Function FN7 key (as in part 4
above) when you are carrying out the search. This does not turn off the projector, just the
signal to it.

A better idea still is to put a copy of your master file on the laptop as a spare image source.
When you need to find that hidden picture, just double click on this file to open up the
images inside as thumbnails. Find the picture you are seeking and with a right click select
Open with Microsoft Office Picture Manager (or Windows Photo Gallery) and your
selected image will open full screen. It will have some surrounding text but this is not too
objectionable. Remember you can again turn off the VGA port when doing this.

Practice this first, of course.
16 The lecture - finally...

You now have a well-planned, carefully assembled, illustrated digital lecture all ready to
run. You have practised it a number of times, and hopefully memorised much of what you
want to say as you show each image of the sequence. Unnecessary pictures have been
discarded, and the timing has been honed to an exact length. At this stage, an additional
aid can be to view the images again in their thumbnail form and to print them out as a
contact sheet. You can use it to run through your lecture at any convenient time and place,
without having to turn on your computer or laptop. A well-rehearsed lecture, spoken
without constant referral to notes, always has maximum impact.

Laptop, projector and cables are all prepared. The laptop battery is fully charged and the
lecture folder is on your hard drive and readily accessible from the deskrop. You might
even have a spare copy of the lecture folder on a memory stick in your pocket.

The last item you might treat yourself to is a cordless presenter remote control, which will
cost around £40. It is a handheld unit which sends a radio pulse to your laptop when you
press a button. The pulse is picked up by a small plug-in unit on the USB port of your
laptop and turns the images over, forwards or back, without you having to lean over and
press your laptop buttons to change every picture. Many of these units contain a laser
pointer, and the more sophisticated ones even have a timer incorporated which can be set
to give a small vibration in your hand after say fifty minutes — a great hint that you have
to wrap up and shortly bring your lecture to a close!
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14 Dedicated projection programmes

If you have followed the suggestions above, it is quite possible to show your slides using
Windows Explorer, or perhaps Microsoft Office Picture Manager, or Irfan View. However if you use a
dedicated presentation programme you can create a superior show.

By far the most well known programme is PowerPoint. If you have Microsoft Office installed in
your computer, then you could well have PowerPoint. This comprehensive programme
allows you to sort your images, put the presentation together, and then use it to show the
pictures. It is not a simple programme for a beginner, but the basics to set up and project
a straightforward picture lecture can easily be learnt. It is not in the remit of this article
to go into the full details of its use. There are many articles and books available, and the
full programme can be used to project video, print out notes for the audience and a host
of other facilities if needed. However, you can bypass all the complicated preliminary
parts of the programme, and just load your pre-prepared folder into PowerPoint and then use
the final presentation part of the software to project the sequence. (See Appendix K.)

A presentation programme also enables features such as a fade in and fade out to be made
between successive images. The resultant merging in and out of successive pictures
creates a very professional effect. (Fades are called dissolves in some presentation
programmes.) This not only makes the viewing easier for the audience, but the subtle
merge out from one sl/ide and then in of a new image will give a speaker a visual hint as
a reminder of the content of the next image. This can aid the speaker’s flow and hence
can improve the overall delivery. We are so used to seeing sophisticated presentations on
television that audiences are used to special effects, but don’t be tempted to use starbursts
or wipes between images in any serious lecture — they can be very distracting.

Don’t forget that if you have PowerPoint installed on one computer, then you can compose
your lecture on that computer, save the lecture and load it into a free small programme
called PowerPoint Viewer on, for instance, your laptop. This means that a fully prepared
presentation can be given on a secondary computer without having to buy a full version
of PowerPoint for that machine. (See also Appendix K.)

If you don’t have PowerPoint on your machine, then may I recommend a small presentation
programme called Pictures to Exe (Also more details in Appendix K.)

I5 Projecting single images in that 'question and answer' session!

At the end of a formal lecture questions may be asked about a certain picture which may
well be buried somewhere in the middle of the sequence. It is a good idea to be prepared
for this eventuality, especially in an important presentation.

If you use PowerPoint Viewer or Pictures to Exe, then you will not be able to readily jump to a
selected picture, and so this can mean flicking backwards or forwards through the images
which can be very annoying to the audience.
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be seen at the back of the hall. The ideal
is to have the script as large as possible,
but not so that it’s broken into too many
lines or masks too much of the picture.
When the name has been written, the
image and text may have to be merged
in the programme to consolidate the
script with the picture. Don’t do
anything else to the image apart from
the lettering. Then save it without
altering the picture name and it will
replace the original b picture. See
examples of text addition figs 3 and 4.
(Merging is detailed in section 12)

11 Maps and other illustrations

Travel lectures benefit from maps, and
occasionally other graphics are needed
to illustrate a lecture. Occasionally
images from the internet may need to
be used in a lecture sequence — they
should be downloaded and saved as
JPEG images.

A word of warning here: many of these web images are of a low picture quality (low pixel
density). They appear fine when viewed on a part of your computer screen but may well
look poor when projected full size. Often web images are low quality to prevent illegal
copying of a copyright picture and there is no way of improving such pictures, and quite
rightly so! A good example of this is that the thumbnail images from most botanical online
libraries or from nursery catalogues are rarely suitable for projection. If such a picture is
the only one available, then you have to compromise between using a very small image
and enlarging it to full screen size when it would probably be grainy and blurred (often
called pixellated because it shows the pixels much enlarged). Just a small amount of
enlargement is probably the best, which requires some experiments to get it right.

Maps are a different matter, and can be scanned or photographed to make digital images
from hard copy (usually images on paper). Strictly speaking, images from books are
usually under copyright and scanning is illegal. A single image used for educational
purposes in a lecture is unlikely to raise any eyebrows, but it is the responsibility of
anyone doing this to be aware of the legality.

Google maps have revolutionised using map images for presentations. They are copyright-
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free, can be scaled, and are ideal to illustrate travel and plant photography trips. Routes
on maps can be treated just like title slides (see section 10 above), with the original map
used for orientation and then a second image made on the first with a route or places
drawn or highlighted. Successive images can be made with the route and places drawn in
and superimposed on the original image. This really aids the clarity of the presentation.
Photoshop is ideal for this type of image superimposition. Again more details in Appendix
K on using Google map in presentations.

Other images and diagrams can be made with a simple drawing programme. The end
result should be a JPEG image, to make it easier to import into the final projection
sequence. The small programme called Paint found in all Windows PCs is ideal because
the images made in it can be directly saved in JPEG format.

12 Lists and text

The written word can easily be incorporated and used in any picture sequence. In the past,
adding lists and scripts often required quite complicated, specially made film-slides. This
has all changed. Text can be scanned in or, better still, made especially for projection as
a dedicated image in many of the image programmes mentioned here. Do note that a page
of script created in Microsoft Word cannot just be saved as a JPEG image and used directly as
a projection picture. However it can be cut and pasted into either a Power Point image or a
Photoshop image and used that way. There is also a separate send to command in Word so that
script can be directly exported from that programme, and used in a Power Point image. See
Appendix G for details on adding text and making text images.

As with maps, another method to incorporate text and other images is to scan them. The
scans can be saved directly as JPEG pictures,, but beware that they may not be of the
highest quality.

In reality though, most lecturers will wish to avoid lengthy lists on the screen. The basic
script facility in Power Point and in Photoshop may well be quite sufficient to create the simple
lists which should appear in an average lecture. Remember you are not going to pack in
too much text: the audience at the back of the hall must be able to read it easily. There is,
however, one golden rule which a good lecturer will never break — though it happens time
after time: it is to avoid reading out from the screen a list which the audience is quite
capable of reading themselves — it demeans their intelligence and can be very irritating to
a knowledgeable audience. By all means use the lists as a guide to making other
comments, but steer clear of using too many of the actual words on the screen.

An aid to speaking about the subject matter on a list you have projected, rather than
reading it off the screen is to mark each item with a bullet. Bullets are small circles or
other marks which distinguish the different components of the list. To make their use
effective, it is necessary to duplicate the text list and make several identical images of that
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list, the number of duplicate images matching the number

of items on the actual list: for instance, if there are four Stigma
items on a list then the image would be duplicated four

times. Each image in turn is then brought up in a Style
programme such as Photoshop and one of the items on the list

is marked with a coloured circle or a symbol marking a Ovary

different item on each slide. Projecting the four slides
appropriately will enable the audience to see all the four

items, but the item you are talking about at that particularly = Stigma

time will be ‘bulleted’ so there is no confusion about where

in the list the speaker has arrived at. (See figs 5, 6, 7 and 8.) Style
Ovary

Highlighting text is another useful method and an
alternative to bullets in a list. This can also be done easily
in Photoshop simply by highlighting a word or words, then

using the colour picker box towards the right hand end of S
the options toolbar, choose a new text colour for that = Stvi
selection. Press OK, and the text colour will change. tyle
. . Ovary
Putting bullets on a scanned JPEG image has to be
performed in Photoshop.
I3 Highlighting on picture images Stigma
L . Style
Just as a marker pen can be used to highlight a portion of
the printed page, and Photoshop and PowerPoint can be used to = Ovary
highlight sections of lists, portions of images can be
highlighted in a very similar manner to accentuate parts of
figs 5,6,7 & 8

an image.

This is particularly useful when, for instance, a lush, well-
planted herbaceous border is shown as the primary image, and a particular plant or group
in that border is to given special attention in the lecture.

In Photoshop, a simple way is to use the pen tool to draw a line around a designated plant.
However a far more sophisticated method is to select the critical part of the picture, then
to blur or change the colour, or perhaps de-saturate (change to black and white) the rest
of the image. This means that the important selected part is in effect highlighted
compared to the rest of the picture. (More on this in some detail in Appendix H.)
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